COMPUTER WHIZ
An Introduction to Computers
Teaching Guide

Sameena M. Haidermota

OXFORD UNIVERSITY PRESS
# Introduction

<table>
<thead>
<tr>
<th>Introduction to the Teaching Guides</th>
<th>vi</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guidelines</td>
<td>1</td>
</tr>
</tbody>
</table>

## Chapter 1

### Reviewing Computers

- Teaching objectives
- Learning outcomes
- Lesson plans
- Answers
- Whiz’s Tasks
- Additional Activity

## Chapter 2

### Pioneers of Computers

- Teaching objectives
- Learning outcomes
- Lesson plans
- Answers
- Additional Activity
Chapter 7
Programming Languages
Teaching objectives 31
Learning outcomes 31
Lesson plans 31
Answers 32
Additional Activity 35

Chapter 8
More on Multimedia
Teaching objectives 37
Learning outcomes 37
Lesson plans 37
Answers 38
Additional Activity 41

Chapter 9
Computer Networks
Teaching objectives 42
Learning outcomes 42
Lesson plans 42
Answers 44
Additional Activity 45
Introduction

Computers have become an integral part of our everyday lives. We use computers everywhere. Hence, a clear understanding of basic computer concepts and applications is vital.

The Computer Whiz (Third Edition) series provides students with detailed basic knowledge of computers at the primary level. The computer is presented to children through Whiz, the mascot, to create interest and visual appeal. Varied activities reinforce their understanding of the different concepts. The new features, fresh layout, and stimulating exercises added to this edition will help develop computer skills and enhance student learning.

Whiz’s Files is a list of chapters in the book with teaching objectives and learning outcomes.

Word Whiz consists of activities involving the use of new words introduced in each chapter.

Whiz’s Commands includes tips on conduct, etiquette, and safety while using the computer and the Internet.

Whiz Bytes provides interesting facts about computers to students.

Explore with Whiz consists of interesting and challenging exercises/activities that review the concepts that have been learnt in the chapter.

Whiz’s Tasks comprise of worksheets provided in the Teaching Guides for classroom practice.

Whiz through Lab encourages the children to do practical work and helps develop their skills on the computer.

Whiz through Projects promotes intellectual and social skills and encourages teamwork.

Whiz’s Notes at the end of each chapter offers a summary of the important points.

Whiz’s Word File at the end of each book is a glossary. It is a list of computer terms with clear definitions.

Introduction to the Teaching Guides

The Teaching Guides provide helpful tips, lesson plans, and worksheets with engaging activities that support learning. They act as a framework to help you develop your own lesson plans and teaching strategies.

Each chapter has a list of objectives and learning outcomes. You must try to realize these objectives at the end of each lesson. Sample lesson plans have been provided on the basis of which you can develop your own plans.

A good lesson plan consists of a starter activity for 3-5 minutes which introduces the concepts being taught followed by a 20-minute activity that encourages students to interact with each other. Please engage the quieter children too. This may be followed by feedback of the discussion in larger groups on which you can spend about 10 minutes. Reinforcement of the entire lesson, summarizing, and time for assigning
homework should be at the end of each period for about 2-3 minutes. Students should be taken to the computer lab as required. The more practical experience on the computer, the more proficient the students become at using computers.

Guidelines
While students are working at the computer, discuss the importance of maintaining good posture. Students will probably spend a lot of time at the PC, barely moving, and with their eyes fixed on the screen. Extended use of the computer can have serious consequences on a child’s health; a child can develop weak eyesight and severe back problems. It is very important to make students aware that they should not use computers for hours on end. It is important for you as well as your students to be aware of what they should do and things they should avoid doing while using the computer.

Dos and Don’ts
Do...
• have your chair at the right height so that your eyes are level with the computer screen
• have your computer screen directly in front of you
• make sure your chair has a good backrest
• keep your shoulders and back relaxed
• make sure that your wrists rest on the desk
• let your feet be flat on the floor
• take regular breaks
• adjust the position of the computer so that there is no glare on the screen
• make sure you have a protection screen on top of the monitor screen.

Don’t...
• fix your eyes on the screen continuously
• lift your shoulders while you type or move the mouse
• twist your body to reach out for computer hardware
• use your PC in poor lighting.
Teaching objectives

The objectives of this chapter are to:
• introduce different kinds of computers
• explain the features of a computer and its basic operations
• teach students how to take care of computers.

Learning outcomes

By the end of this chapter, the students should be able to:
• summarize what a computer can do
• define input, processing, and output
• explain how to keep computers in good working condition.

Suggested number of periods: 3

Period 1

Sample lesson plan for a 40-minute period

Starter activity (5 minutes)
Write the following questions on the board in three columns and let the students brainstorm possible responses in pairs or groups.
Collect feedback from the students and write down their responses on the board.

• Why has the use of computers become so widespread?
  Expected responses: because computers are quick and accurate; because computers are versatile and multipurpose; because computers can be programmed to serve the user; because they are an efficient, inexpensive, and a speedy way of collecting and communicating information, etc.

• What is artificial intelligence?
  Explain that a computer that thinks like a human is supposed to have artificial intelligence. Once the meaning is clear, ask them why there is a need for artificial intelligence in a computer.
  Expected responses: to make computer operations as close to human operations as possible; to enable the computer to make decisions that are different from what it does as default in certain circumstances, etc.

• What precautions should be taken to ensure that a computer works efficiently?
  Expected responses: keeping liquids away from the computer; keeping the computer away from the direct rays of the Sun; pressing the keys gently; keeping dust off the computer, etc.
**Features of a computer (page 2) (10 minutes)**
Explain the meaning of the word ‘computer’ and emphasize its efficiency and accuracy compared to human or manual processing. Read out the text on page 2 of the textbook and ask students to remember the features of a computer.

Ask students to answer the question given on page 2.

**Mainframes, minicomputers, and microcomputers (page 3) (5 minutes)**
Explain how computers are classified as mainframes, minicomputers, and microcomputers. Compare various aspects of these computers such as number of users supported, processing and storage capacity, possible applications, cost, and size. Help students identify various types of microcomputers such as laptop computers, tablet computers, and desktop computers in their environment.

**Supercomputers (page 4) (5 minutes)**
Discuss the features of supercomputers while introducing them as the most sophisticated computers around. Explain the environments where supercomputers are used because of their high processing speeds.

**Analog, digital, and hybrid computers (page 5) (10 minutes)**
Explain how computers are classified according to the manner in which they process and present data to users. Students should understand that an analog computer presents accurate data but in a form that users cannot read with precision. Give the example of an analog clock and explain that it is difficult to specify the time when the seconds hand is between two second divisions. On the other hand, digital computers provide output in a form that can be read with precision.

After reading pages 3, 4, and 5 of the textbook students should jot down points in the following table:

<table>
<thead>
<tr>
<th>Different Kinds of Computers</th>
<th>Features</th>
<th>Places they are used</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Word Whiz (page 7) (5 minutes)**
Assign the Word Whiz exercise on page 7 as classwork.
Period 2
Lesson plan for a 40-minute period

Starter activity (5 minutes)
Write the words ‘input’, ‘processing’, and ‘output’ on the board and ask students if they remember what these words mean. Help students recall the different ways in which data is entered into a computer. Draw a linear diagram to explain that data-processing flows from the input stage to the processing and output stages.

Input, processing, and output (pages 6-8) (20 minutes)
Read out page 6 of the textbook and explain the different stages of data processing in a computer. Discuss the example given on the page to identify the input, processing, and output stages. You could ask students to brainstorm more examples of data processing by a computer.

Ask students to attempt the question given on page 7 of the textbook.

Discuss the role of input and output devices while reading page 8 of the textbook. Students should be familiar with several input and output devices from earlier classes. Hence, they should be directed to attempt the exercise given on page 8 independently.

Explore with Whiz (page 9) (15 minutes)
Assign the Explore with Whiz exercises on page 9 to be completed in class.

Period 3
Lesson plan for a 40-minute period

Whiz’s Quiz (page 10) (30 minutes)
Help students explore and write down answers to the Whiz’s Quiz section in their notebooks. Encourage originality instead of copying text from the chapter.

Whiz’s Tasks (10 minutes)
Assign the Whiz’s Tasks activity to be attempted on the worksheet.

Answers

How have computers benefitted you? (page 2)
Student responses will vary depending on their personal experiences.

Give examples of input, processing, and output. (page 7)
Expected responses: using the calculator feature of the computer to add numbers; locating a file using the Search feature; entering text in a Word document; etc.

Word Whiz (page 7)
Write the opposites of the following words.
multiple: single
support : abandon, oppose
expensive: cheap
newest: oldest
Draw lines to match the words to their meanings.
classify: arrange things in groups
solve: find a solution
automate: use a machine instead of people

Label the pictures below and state what kind of devices they are. (page 8)
keyboard (input device), speakers (output device), mouse (input device), scanner
(input device), graphics tablet (input device), printer (output device)

Explore with Whiz (page 9)
Solve the clues and write the answers.
displays output: monitor
processes data into information: CPU
personal computer: microcomputer
powerful but bulky: mainframes
electricity meter: analog computer

Are these statements true or false?
1. False.
2. False.
3. True.
4. True.
5. False.
6. True.
7. False.
8. True.

Whiz's Quiz
1. What are the three important characteristics of computers?
   Computers are extremely fast and can carry out hundreds of instructions in
   minutes.
   Computers are very accurate. They do not make mistakes.
   Computers follow instructions and only do what they are told.
   Computers store all the information in their memory.
   Computers can work continuously without stopping
   (Students may mention any three of the above characteristics.)

2. Which computers should banks use? State your reasons.
   Banks should use mainframes because they are powerful computers with large
   storage capacity that hundreds of people can use at the same time.

3. How is a supercomputer different from a mainframe?
   A supercomputer works on a single problem at a time unlike a mainframe which
   can support many problems and users at a time.

4. List the differences between analog and digital devices.
   Analog computers work at an extraordinary speed. They can solve the most
   complex equations in seconds. They have limited memory and can perform only
   certain types of calculations.
Output from analog computers cannot be read with great precision.
Digital computers produce results that can be read with greater precision, but are slower than analog computers. They are easier to program.

5. Define input and output devices.
   Input devices are those devices that help us enter data and programs into the computer. Output devices are those devices that display processed data.

Answers to Additional Activity
1b, 2b, 3a, 4b, 5b, 6a
Whiz’s Tasks

Connect the name of each device with its picture and function by drawing lines across the three columns.

- mouse

- printer

- monitor

- speakers

let us point at items on the screen
Additional Activity

How well do you know the different kinds of computers?

(1) What type of computer is a desktop computer?
   (a) mainframe
   (b) microcomputer

(2) Which of these has the greatest processing capacity?
   (a) microcomputer
   (b) supercomputer

(3) What type of device is a speedometer?
   (a) analog
   (b) digital

(4) Which part of the computer processes data?
   (a) monitor
   (b) CPU

(5) Which of these organizations would use a supercomputer?
   (a) a bank
   (b) a research laboratory

(6) Which of these devices produces precise output?
   (a) hybrid
   (b) digital
Teaching objectives
The objectives of this chapter are to:
• inform students about the pioneers of computers
• make them aware of the role each pioneer played in the development of computers.

Learning outcomes
By the end of this chapter, the students should be able to:
• outline the contributions made by each pioneer.

Suggested number of periods: 2

Period 1
Sample lesson plan for a 40-minute period
Starter activity (5 minutes)
Bring some pictures of the pioneers and their inventions to class and put them up on the board. Ask students if they know who these people are and what the machines are called. Explain that these machines are the earlier forms of computers. Draw a timeline on the board and ask students to draw a similar timeline in their notebooks to fill out as the lesson progresses.

Timeline for showing the pioneers of computers and their contributions

<table>
<thead>
<tr>
<th>Year</th>
<th>Pioneer</th>
<th>Contribution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Blaise Pascal and the Pascaline (page 12) (10 minutes)
You could select two students to act the parts of Whiz and Blaise Pascal as given on page 12. As students read the lines, highlight the operations that the Pascaline could carry out, i.e. addition and subtraction.

Ask students to attempt the question given on page 12 of the textbook.

Gottfried Leibniz and the Leibniz Calculator (page 13) (5 minutes)
As in the previous case, select two different students to read out the lines spoken by Whiz and Gottfried Leibniz. Encourage students to put in a lively performance when playing their respective parts. The purpose should be to impart the information contained in this chapter in a child-friendly way. Emphasize that the Leibniz calculator could multiply and divide in addition to adding and subtraction.

Charles Babbage (page 14) (10 minutes)
Once again, select two different students to speak the lines spoken by Charles Babbage and Whiz. Explain the function of the analytical and difference engines. Emphasize the ambitious nature of these machines and their significance in the development of the modern electronic computer.

The tabulating machine (page 15) (5 minutes)
Fill up the timeline on the board with the inventors, machines, and years as each topic is covered. Do the same after the students have read out the lines for Herman Hollerith and Whiz.

Word Whiz (page 15) (5 minutes)
Ask students to attempt the Word Whiz activity on page 15.

Assign the Explore with Whiz exercises on pages 16 and 17 as homework.

Period 2
Sample lesson plan for a 40-minute period

Exercise (page 17) (5 minutes)
Ask students to attempt the exercise on page 17 of the textbook.

Whiz’s Quiz (page 17) (35 minutes)
Help students explore and write down answers to the Whiz’s Quiz section in their notebooks. Encourage originality instead of copying text from the chapter.

Answers

How is the present day calculator different from the Pascaline? (page 12)
The present day calculator has buttons compared to the Pascaline which had eight movable dials. The present day calculator can perform many complex calculations but the Pascaline could only add and subtract.

Word Whiz (page 15)
Find the words that mean the following:
follow procedures: process
make a hole in something: punch
arrange information in a table: tabulate
Explore with Whiz (pages 16 and 17)
Label the machines. Write the names of the pioneers. Draw an arrow from the pictures of the pioneers to the machines they invented.
Names of pioneers (down the column): Charles Babbage, Gottfried Leibniz, Blaise Pascal, Herman Hollerith
Names of machines (down the column): tabulating machine, Leibniz calculator, analytical engine, Pascaline
Pioneers and their machines: Charles Babbage, analytical engine; Gottfried Leibniz, Leibniz calculator; Blaise Pascal, Pascaline; Herman Hollerith, tabulating machine

Circle the correct answers.
1. Pascaline
2. multiply and divide
3. difference engine
4. punched cards

Unscramble the jumbled words to see what modern computers can do. (page 17)
1. programmed
2. programs
3. Internet

Whiz's Quiz
1. Who was Blaise Pascal and what did he invent?
   Blaise Pascal was a French mathematician and physicist. He invented an early mechanical calculator called the Pascaline. The Pascaline had eight movable dials which were used to add and subtract numbers.

2. What did Leibniz develop? In what way was he successful?
   Leibniz developed the first mechanical calculator called the stepped reckoner. He was successful because the binary number system he created was used in the future in all digital computers.

3. Why is Babbage called the father of the modern computer?
   Charles Babbage is called the father of the modern computer because all computers today are based on his plans and ideas.

4. Why is Herman Hollerith considered a pioneer of computers?
   Herman Hollerith is considered a pioneer of computers because he invented the punched card which could store data and the tabulating machine which could process data stored on punched cards. He started the Computing-Tabulating-Recording Company which later became IBM.

Answers to Additional Activity
1a, 2b, 3c, 4c, 5c
Additional Activity

Choose the name of the correct machine and fill in the blanks.

(1) The Pascaline used ______ to make calculations.
   (a) dials
   (b) bars
   (c) holes

(2) The Leibniz calculator is also called the ______.
   (a) analytical engine
   (b) stepped reckoner
   (c) tabulating machine

(3) Computers today are based on the work done by ______.
   (a) Hollerith
   (b) Pascal
   (c) Babbage

(4) Which of these machines is the most advanced in terms of processing?
   (a) Leibniz calculator
   (b) Pascaline
   (c) Analytical engine

(5) Who played an important role in developing the binary number system used in all modern computers?
   (a) Charles Babbage
   (b) Blaise Pascal
   (c) Gottfried Leibniz
Chapter 3

About the CPU

Teaching objectives

The objectives of this chapter are to:
• explain the different parts of the CPU
• discuss the different disk drives attached to the CPU.

Learning outcomes

By the end of this chapter, the students should be able to:
• describe the functions of the ALU, MU, and CU
• summarize the role of the different disk drives attached to the CPU.

Suggested number of periods: 2

Period 1

Sample lesson plan for a 40-minute period

Starter activity (10 minutes)
Write the word ‘CPU’ on the board and ask the students what it stands for and what functions the CPU performs.

Expected responses: CPU stands for central processing unit. The CPU controls the processes and functions of a computer; it enables the computer to perform its tasks, etc.

The CPU (page 19) (10 minutes)
Explain the role and functions of the CPU while reading page 19 of the textbook. Explain the function of the microprocessor and where it is located inside the system unit. Refer to the photograph to explain that the CPU and microprocessor are housed inside the system unit. Explain that the system unit should not be referred to as the CPU or processor.

Ask students to attempt the exercise on page 19.

Components of the CPU (page 20) (10 minutes)
Draw a web around the word CPU written on the board and write the names of the different parts around it. Extend the web further by asking students to read and identify the functions performed by the various parts, such as the ALU, CU, and MU. Once identified by the students, explain the functions of the different parts.

ALU: The arithmetic logic unit calculates and makes logical comparisons and decisions.
CU: The control unit directs different parts of the computer to carry out instructions. It coordinates the input and output devices.
MU: The memory unit stores data and instructions for processing.
Explain how the diagram on page 20 describes the components of the CPU and their functions. Refer to what Whiz is shown doing in the diagram to help students remember the function of each component.

**Word Whiz (page 21) (5 minutes)**
Ask students to attempt the Word Whiz exercise on page 21 of the textbook.

**Exercise (page 21) (5 minutes)**
Ask students to attempt the exercise on page 21 of the textbook.

**Period 2**

**Sample lesson plan for a 40-minute period**

**Disk drives (page 22) (10 minutes)**
Ask students if they know what disk drives are and what they are used for.
Expected responses: Disk drives are those parts of a system unit in which data storage devices such as USB drives, CDs, etc. can be plugged for use.

Show the students a CD, DVD, and USB. If possible, take students to the lab to show them a hard drive or bring one into class. Ask students to explain the similarities and differences between these devices. If possible, you could bring in a system unit and identify the various drives on it. Explain that students must always handle CDs and DVDs carefully so they do not get scratched.

Assign the matching activity and Explore with Whiz exercises on pages 23 and 24 as homework.

**Whiz’s Quiz (page 25) (30 minutes)**
Help students explore and write down answers to the Whiz’s Quiz section in their notebooks. Encourage originality instead of copying text from the chapter.

**Answers**

**Does the CPU do the following? Answer with a yes/no. (page 19)**
1. No.
2. Yes.
3. No.
4. No.

**Word Whiz (page 21)**
Identify the words from the given meanings.
*communication, coordination*

**Which part of the CPU is used for the following? (page 21)**
to calculate the total books an author has sold: ALU
to get a scanned copy of a picture: CU
to see a flight schedule on the monitor: CU
to retrieve data stored on the computer: MU
Explore with Whiz (pages 23 and 24)

Tick the correct statement.
1. The arithmetic logic unit performs all arithmetical calculations.
2. The disks in the hard disk drive are protected in an airtight case.
3. The control unit controls communication between input/output devices.
4. We can store films on DVDs.
5. We can attach input and output devices as well as the USB flash drive to a USB port.

Whiz’s Quiz (page 25)
1. Why is the CPU called the brain of the computer?
The CPU is called the brain of the computer because it controls and processes all the information in the computer. It also directs and controls the flow of information through output devices. The computer cannot function without the CPU.

2. Name the three components of the CPU.
The three components of the CPU are the arithmetic logic unit or ALU, the control unit or CU, and the memory unit or MU.

3. How is the ALU different from the CU?
The ALU performs all arithmetical calculations and makes all logical decisions whereas the CU controls communication and coordination between input/output devices and the computer. The CU also directs different parts of the computer to carry out instructions.

4. Why are the disks in the hard disk drive sealed in an airtight case?
The disks in the hard disk drive are sealed in an airtight case to protect them from dust.

Answers to Additional Activity
1b, 2b, 3a, 4a, 5b
Additional Activity

Select the correct answer.

(1) Which part of the CPU stores data?
   (a) CU
   (b) MU

(2) Which part of the computer coordinates input and output devices?
   (a) ALU
   (b) CU

(3) In which of these drives do we insert a flash drive?
   (a) USB
   (b) CD

(4) Which of these devices stores more data than the other?
   (a) DVD
   (b) CD

(5) Which part of the CPU is responsible for processing data?
   (a) CU
   (b) ALU
Teaching objectives

The objectives of this chapter are to:
• introduce the two kinds of memory
• explain primary and secondary storage
• discuss different storage devices.

Learning outcomes

By the end of this chapter, the students should be able to:
• differentiate between RAM and ROM
• identify and describe the functions of a hard disk, CD, and USB flash drive.

Suggested number of periods: 3

Period 1

Sample lesson plan for a 40-minute period

Starter activity (10 minutes)
Write ‘Computer Memory’ on the board and ask students where the computer’s memory is situated. Students should recall from earlier chapters that the computer’s memory is situated in the memory unit of the CPU. Probe students’ memories further so that they recall external storage devices such as CDs, DVDs, and USB drives.

Internal memory (pages 27 and 28) (15 minutes)
Ask students if they remember the hard drive of the computer. They should recall it from the discussion of disk drives in the previous chapter. Explain that the computer comes with an installed capacity for data storage which is called internal memory or primary memory. You can write these terms on the board so students can remember them.

Next, discuss the concept of ROM and RAM and their relationship with power supply to the computer. Refer to the diagram on page 27 to explain that data stored in RAM is lost when power supply is disconnected, whereas in ROM data is not lost even after power supply is disconnected.

Ask students to attempt the exercise given on page 28 of the textbook.

Primary and secondary storage (page 29) (15 minutes)
Introduce the concepts of primary and secondary storage. Explain that the internal memory of the computer is its primary memory which is installed by the manufacturer. Explain that users might need to store more data than the primary memory has capacity for. Furthermore, they might need to carry data around without having to carry the heavy computer. This is where secondary storage plays a useful role.
Identify the various secondary storage devices through the photographs given on page 29 of the textbook. You could also bring in some of these devices from the lab and show them to the students.

Ask students to attempt the exercise given on page 29 of the textbook.

Period 2

Sample lesson plan for a 40-minute period

Magnetic storage devices (page 30) (10 minutes)
Explain that primary and secondary storage devices can be classified according to how data is stored on them. Describe briefly the difference between storing data on magnetic tape or disks and storing data using laser beams. Write the terms magnetic storage on the board and discuss the hard disk as a magnetic storage device.

Refer to the picture of the internal hard disk to show the magnetic disk and the spindle used to record and read data from the disk. You could bring in a hard disk and show it to students. You could also bring in a floppy disk and remove the magnetic disk from the jacket to show students what a magnetic surface looks like.

Explain that external hard drives enable us to increase the storage capacity of the computer.

Optical storage devices (page 31) (10 minutes)
Introduce optical storage devices as devices based on advanced laser technology compared to the older magnetic tape technology. You could show various CDs, DVDs, and USB flash drives to the students. Emphasize that these devices are much smaller than magnetic devices such as hard drives and the older floppy disks and can be carried around easily.

Word Whiz (page 31) (5 minutes)
Ask students to attempt the Word Whiz exercise on page 31 of the textbook.

Explore with Whiz (page 32) (15 minutes)
Ask students to attempt the Explore with Whiz exercises on page 32 of the textbook.

Period 3

Sample lesson plan for a 40-minute period

Whiz’s Quiz (page 33) (40 minutes)
Help students explore and write down answers to the Whiz’s Quiz section in their notebooks. Encourage originality instead of copying text from the chapter.

Answers
Fill in the blanks. (page 28)
1. ROM
2. random access
3. RAM
4. Read only
5. RAM
Are the following statements true or false? (page 29)
1. True.
2. False.
3. False.
4. True.
5. True.

Word Whiz (page 31)
Draw lines to match the words to their synonyms.
portable: handy
removable: detachable
compact: small

Explore with Whiz (page 32)
Read each clue about a storage device carefully and write the answer in the given space.
USB flash drive, CD, hard disk, external hard disk drive

Underline the correct answers.
1. external hard disk drive
2. compact disc
3. hard disk
4. compact disc
5. USB flash drive

Whiz’s Quiz
1. List two main differences between RAM and ROM.
   RAM is available for the operating system and programs when the computer is running. ROM contains instructions for booting up the computer.
   Data stored in RAM is temporary. Once we turn off the computer, the data is deleted. Data in ROM is permanent and is not erased when we shut down the computer.

2. What do you understand by the term primary storage?
The term primary storage refers to the internal memory of the computer. It includes the main memory or RAM.

3. Can a magnetic disk be used to store new data more than once?
   Yes, a magnetic disk can store and erase data more than once.

4. Name some commonly used secondary storage devices.
   Some commonly used secondary storage devices are CDs, USBs, DVDs, Blu-ray discs, and external hard drives.

5. Why is it important to make back-up copies of data on a secondary storage device?
   It is important to make back-up copies of data on a secondary storage device to avoid losing it permanently if the hard drive fails.

Answers to Additional Activity
1b, 2a, 3b, 4a
Additional Activity

Select the correct answer.

(1) Where are instructions for running the computer stored?
   (a) RAM
   (b) ROM

(2) Which of these is a secondary storage device?
   (a) CD
   (b) internal hard drive

(3) Which of these devices is not used anymore?
   (a) hard drive
   (b) floppy disk

(4) How is data stored on a CD?
   (a) using laser
   (b) using a tape
Teaching objectives

The objectives of this chapter are to:
• explain what computer software is
• outline the features of different software.

Learning outcomes

By the end of this chapter, the students should be able to:
• define software
• differentiate between system and application software
• explain in detail the different kinds of software.

Suggested number of periods: 3

Period 1

Sample lesson plan for a 40-minute period

Starter activity (5 minutes)

Draw the following block diagram on chart paper for the students and pin it up on the board. Ask students what they have learnt to do on the computer. They should name various functions such as drawing a picture on Paint, using the calculator, typing on Word, etc. Explain that all these are programs and that they help us to do different tasks on the computer. In this way, lay the ground for discussing system and application software.

Computer Software/Program

an organized set of instructions that tells a computer what to do and how to do it

System Software

System software is used to control all the activities within a computer system.

Functions: allows the user to interact with the computer at a very basic level, e.g. operating systems, compilers, utilities for managing computer resources, loaders, linkers, and debuggers.

Application Software

Application software is a tool that we use to do specific work on the computer.

Functions: allows the user to create text documents, play games, listen to music, or surf the web, e.g. database programs, word processors, and spreadsheets.
System software and operating system (page 35 and 36) (20 minutes)
Read out the text on page 35 of the textbook and explain the role of software in a computer. Describe the unique functions of system software. You may need to spend more time explaining system software because students may have had very little interaction with it compared to application software. Explain that Microsoft Windows which allows them to access application software they regularly work with is system software.

Assign the exercise and Word Whiz activity on page 35 to be completed.

Introduce the operating system as the most important type of system software. Explain its important functions and role in providing an interface between the computer and the user. Refer to the screenshots on page 36 and explain that Windows and Linux are two different operating systems.

Ask students to attempt the exercise on page 36 of the textbook.

Application software: Word processors, desktop publishing programs, and spreadsheets (pages 37 and 38) (15 minutes)
Introduce application programs and explain that each one is used for a specific purpose. Discuss the different types of application programs such as word processors, desktop publishing programs, and spreadsheets. Refer to the screenshots so that students become familiar with the basic features of each application software.

Explain the purpose for which each of these is used.

Ask students to attempt the exercise on page 38 of the textbook.

Period 2
Sample lesson plan for a 40-minute period

Database management programs (page 39) (20 minutes)
Explain what a database is and why it is important to organize data in a good database. Explain that a well-organized database is essential to store and locate information whenever it is needed. Describe the function of a database management program and some of its features.

Ask students to create the database as required in the exercise on page 39 of the textbook. Allow students to move around the classroom to collect data from their friends.

Web browsers (page 40) (10 minutes)
Explain the function of a web browser and how it helps us to access information available through the Internet. Students should understand that the web browser allows them access to limitless information for research and increasing their knowledge. Refer to the screenshots on the page to familiarize students with how a web browser appears.

Ask students to attempt the question on page 40 of the textbook.

Exercises (page 41) (10 minutes)
Ask students to attempt the Explore with Whiz exercises on page 41 of the textbook.
Period 3

Sample lesson plan for a 40-minute period

Whiz’s Quiz (page 42) (40 minutes)
Help students explore and write down answers to the Whiz’s Quiz section in their notebooks. Encourage originality instead of copying text from the chapter.

Answers

Are these activities controlled by system software? Answer Yes or No. (page 35)
shutting down the computer: Yes
designing cards: No
playing Scrabble: No
booting up the computer: Yes

Word Whiz (page 35)
Unscramble the letters to match the meanings.
hardware, software

Learn more about the functions of an operating system. Fill in the blanks by selecting the correct words from the list. (page 36)
booting up, input, data, instructions, process, save, delete

In which month did the school spend the most on stationery? (page 38)
The school spent the most on stationery in April (Rs 1400).

List three advantages of the Internet. (page 40)
Note: Students may list any three of the following:
1. Information on different topics is available instantaneously.
2. World news is available at a click.
3. Email has made communication easier.
4. Video conferencing is possible through Skype.
5. Students can use it to complete their homework.
6. Communication becomes easier through social media.

Explore with Whiz (page 41)
Are these system software or application software?
Microsoft Access: application software
Linux: system software
Mac OS X: system software
Mozilla Firefox: application software
Microsoft Excel: application software
Microsoft Publisher: application software
Microsoft Windows: system software
Microsoft Word: application software

Match the software to its function.
Mac OS: manages the different parts of the computer
Microsoft Word: helps create a document
Microsoft Office: is a collection of programs to perform specific tasks
Microsoft Excel: is used for calculating, budgeting, and organizing data
Microsoft Publisher: combines text and graphics in a single document

Whiz’s Quiz (page 42)
1. Define software.
   Software is an organized set of instructions that tells a computer what to do and how to do it.

2. What is the difference between system software and application software?
   System software is software used to control, manage, and integrate the functioning of the different parts of the computer. Application software consists of programs used to perform specific tasks.

3. Which software would you use to design a brochure?
   I would use desktop publishing software to design a brochure as it enables us to combine text and graphics in a single document.

4. What does a database management software enable you to do?
   Database management programs enable us to store, retrieve, and manage a large amount of data. Data can be organized in records and files. A database management program also enables us to sort data and keep it up to date. We can create lists of telephone numbers and addresses using database management software.

Answers to Additional Activity
1a, 2c, 3b, 4c, 5c
Additional Activity

Circle the correct answer.

(1) Which of these is not application software?
   (a) Microsoft Windows
   (b) Microsoft Word
   (c) Microsoft Excel

(2) Which of these is not a function of system software?
   (a) starting up the computer
   (b) controlling hardware devices
   (c) creating a spreadsheet

(3) Which of these is not a feature of a word processing program?
   (a) writing letters
   (b) making charts for budgets
   (c) correcting errors

(4) Which of these can be stored in a database?
   (a) names of people
   (b) telephone numbers
   (c) both a and b

(5) Which of these is not a web browser?
   (a) Microsoft Internet Explorer
   (b) Mozilla Firefox
   (c) Linux
Teaching objectives
The objectives of this chapter are to:
• introduce spreadsheets
• discuss the elements of a spreadsheet.

Learning outcomes
By the end of this chapter, the students should be able to:
• explain how a spreadsheet helps in performing simple and complex calculations
• describe the features of the spreadsheet.

Suggested number of periods: 3

Period 1
Sample lesson plan for a 40-minute period
Starter activity (10 minutes)
Distribute a printout of a blank spreadsheet which shows the grid, a highlighted cell, and the cell address numbers and letters. Ask students to suggest what such a program could be used for. After students have answered, proceed to labeling/inserting and discussing the functions of the different terms associated with a spreadsheet—row, column, cell, cell address, active cell, and range.

The students could be instructed to do the following:
• Colour Row D red and Column 6 yellow.
• Identify the address of the cell which becomes orange in colour as a result of the intersection of Row D and Column 6. Explain that the letter is always given first, followed by the number.
• Give the address of the active cell.
• Colour cell F8 blue.
• Colour range B3:B5 green.
• Colour range E7:G9 pink.

Microsoft Excel (page 44) (10 minutes)
Introduce spreadsheet programs and explain how data is organized on a spreadsheet. Have students refer to their own spreadsheet used in the starter activity and compare it with the screenshot on page 44 of the textbook.

Ask students to complete the exercise on page 44 of the textbook.

Elements of a spreadsheet (pages 45 to 47) (20 minutes)
Read out page 45 of the textbook and explain the concept of rows, columns, cells, worksheets, and grid on a spreadsheet. Refer to the screenshots to emphasize the difference between rows and columns and to learn how to refer to rows and columns through numbers and letters.
Ask students to attempt the Word Whiz activity on page 45 of the textbook. Explain that data is entered in a cell on a spreadsheet. Also explain how a cell is referenced by its cell address. Ask students to draw an active cell in the screenshot on page 46 of the textbook.

Next, explain the concept of range and how it is represented through the cell addresses of the first and last cells. Ask students to highlight the range as required on page 47 of the textbook.

Period 2

Sample lesson plan for a 40-minute period

This lesson should be conducted in the computer lab.

Starter activity (10 minutes)
Guide students as they explore spreadsheets through the Microsoft Excel program. Help them identify the parts of a spreadsheet they had learnt about in the previous lesson.

Entering data (page 48) (10 minutes)
Explain the method of entering data in a cell in Microsoft Excel. Explain the difference between labels and values. Allow students sufficient time to practise data entry on the spreadsheet.

Entering formulas (page 48) (10 minutes)
Explain the function of a formula and its essential role in processing data entered on the spreadsheet. Emphasize how data is represented by cell addresses in a formula. Ask students to attempt the exercise on page 48 of the textbook.

Entering charts (page 49) (10 minutes)
Emphasize that we can present data in the form of charts in Microsoft Excel. Charts help to summarize a large amount of data and present it in an attractive way. Help students enter some data in a spreadsheet and create a relevant chart.

Ask students to attempt the question on page 49 of the textbook.

Assign the Explore with Whiz exercises on page 50 as homework.

Period 3

Sample lesson plan for a 40-minute period

Whiz’s Quiz (page 51) (40 minutes)
Help students explore and write down answers to the Whiz’s Quiz section in their notebooks. Encourage originality instead of copying text from the chapter.
**Answers**

The table below tells us how much my mother spent on fruit from January to June. Calculate how much she spent each month. (page 44)

<table>
<thead>
<tr>
<th>Months</th>
<th>Apples</th>
<th>Bananas</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>JANUARY</td>
<td>300</td>
<td>100</td>
<td>400</td>
</tr>
<tr>
<td>FEBRUARY</td>
<td>350</td>
<td>200</td>
<td>550</td>
</tr>
<tr>
<td>MARCH</td>
<td>440</td>
<td>250</td>
<td>690</td>
</tr>
<tr>
<td>APRIL</td>
<td>200</td>
<td>400</td>
<td>600</td>
</tr>
<tr>
<td>MAY</td>
<td>100</td>
<td>220</td>
<td>320</td>
</tr>
<tr>
<td>JUNE</td>
<td>250</td>
<td>310</td>
<td>560</td>
</tr>
</tbody>
</table>

**Word Whiz (page 45)**

Complete the following sentences.
row, column, grid

How can you find the total number of books sold from March to May? Write the formulas and the answers in the respective cells. (page 48)

Cell H6
Formula: =D6+E6+F6+G6
Answer: 217

Cell H7
Formula: =D7+E7+F7+G7
Answer: 146

Cell H8
Formula: =D8+E8+F8+G8
Answer: 65

Use the above spreadsheet to find out which child’s performance was the best. (page 49)
The best performer was Bushra (292 marks).

**Explore with Whiz (page 50)**

What is indicated by the clues?
the portion of the worksheet that we see: window
where a row and a column meet: cell
a number entered into a cell: value
the work area where we fill in data: worksheet
a group of cells: range
Whiz’s Quiz

1. How do spreadsheet programs help us?
   Spreadsheet programs help us to organize data into tables, analyse it by making calculations, and present the data in bar graphs and pie charts.

2. Can we see the entire spreadsheet when we open Microsoft Excel? Explain your answer.
   We cannot see the entire spreadsheet when we open Microsoft Excel because it is too large to fit in the window. The area where we enter data called a worksheet and contains many rows and columns. We can only view and edit the part of the worksheet that can be seen in the window.

3. Explain the importance of the cell address in a spreadsheet program.
   The cell address consists of the column letter and the row number. When we write the cell address, we specify the column first and then the row. The Address Box displays the address of the selected cell. The cell address helps us to locate it and enter data in a formula.

4. How do we identify a range?
   We identify a range by specifying the cell address of the first cell and the last cell of the range.

5. What does a graph represent?
   A graph represents numerical data in visual form.

Answers to Additional Activity
(1) grid
(2) letter, number
(3) A5:G12
(4) equals (=)
(5) charts
Additional Activity

Fill in the blanks.

(1) A spreadsheet enables us to enter numerical data in a ________.

(2) A cell address consists of a column ________ and row ________.

(3) A range of cells from the fifth row in column A to the twelfth row in column G is written as ________.

(4) A formula always begins with the ________ sign.

(5) Column, pie, and bar are types of ________.
Teaching objectives

The objectives of this chapter are to:
- introduce programming languages and their features
- discuss algorithms, flow charts, and block diagrams
- introduce BASIC.

Learning outcomes

By the end of this chapter, the students should be able to:
- explain programming languages
- create algorithms, flow charts, and block diagrams.

Suggested number of periods: 3

Period 1

Sample lesson plan for a 40-minute period

Programs and algorithms (page 53) (5 minutes)
Ask students to recall a time when they learned a new skill such as riding a bicycle or using a new mobile phone. Ask them how they would teach the same skill to someone else. Working with the students' responses, guide them to understanding the importance of step-by-step instructions to perform a job or task.

Introduce the terms program and algorithm and explain what they mean. Students should understand that an algorithm is a written set of step-by-step instructions to perform a task. Refer to the example given on the page and ask students if they think they can make French toast after reading the algorithm.

Flow charts (pages 54 and 55) (15 minutes)
Explain what a flow chart is and its role in developing an algorithm. Ask students to study the flow chart to start up a computer. Ask them to use the flow chart to teach someone to start up the computer.

Ask students to attempt the exercise on page 55 of the textbook.

Programs (page 56) (15 minutes)
Explain that an algorithm and flow chart are used to write the final program, which is what the computer executes to perform a task. Explain that a program consists of instructions that a computer can execute after processing.

Ask students to attempt the exercise on page 56 of the textbook.

Block diagrams (page 57) (5 minutes)
Explain the concept of block diagrams and the use of connectors to show the relationship between the objects represented by the blocks. Ask students to trace Whiz's family tree through the block diagram on page 57 of the textbook.

Assign the exercises on page 58 as homework.
Period 2

Sample lesson plan for a 40-minute period

Programming languages (20 minutes) (page 59)
Ask students in what language they wrote the algorithms and flow charts for the previous exercises. They will reply that they wrote them in the English language. Ask them if they could have been written in any other languages. The students should reply in the affirmative since the instructions may be written in any language the reader understands.

Explain that programming languages are special languages used to write programs for the computer. You could name different programming languages such as BASIC, COBOL, Fortran, Java, etc. as examples of programming languages. Explain that, over time programming languages have become easier to write programs in.

Describe the unique features of the BASIC programming language that make it a popular language to teach young computer programmers.

Ask students to attempt the question on page 59 of the textbook.

Explore with Whiz (page 60) (20 minutes)
Ask students to attempt the Explore with Whiz exercises on page 60 of the textbook.

Period 3

Sample lesson plan for a 40-minute period

Whiz’s Quiz (page 61) (40 minutes)
Help students explore and write down answers to the Whiz’s Quiz section in their notebooks. Encourage originality instead of copying text from the chapter.

Answers

Write an algorithm and draw a flow chart showing the correct way to shut down a computer. (page 55)
Algorithm to shut down the computer:
1. Click on the Start button on the taskbar.
2. Click on the Shut down button.
3. Wait for the computer to shut down.
4. Switch off the monitor.
5. Switch off the system unit.
6. Switch off the main power supply.
Start

Click on the Start button.

Click on the Shut down button.

Wait for the computer to shut down.

Switch off the monitor.

Switch off the system unit.

Switch off the power supply.

End
Can you give an example of an algorithm for a computer program? State what the algorithm is for and then list the steps. (page 56)

Students’ answers will vary, but they could include programs for opening a file, displaying scoring during a game, saving a Paint file, etc.

Word Whiz (page 58)
Find two words in this chapter that are similar in meaning.
relationship, connection

Find out the names of four programming languages other than BASIC. (page 59)
Java, COBOL, Fortran, Cobra

Explore with Whiz (page 60)
Fill in the blanks.
Instructions, algorithm, flow chart, block diagram

Whiz’s Quiz
1. What are algorithms used for?
   Algorithms are used to explain a procedure in easy to understand steps.

2. How are computer programs written?
   Computer programs are written in specially developed programming languages. A computer program is written after an algorithm for the task has been written.

3. What is a block diagram?
   A block diagram is a series of blocks connected by arrows to show the relationships between the different blocks.

4. What is BASIC?
   BASIC is a simple programming language that is easy to learn. Instructions in BASIC are written using common English words which makes them easy to understand for readers.

Answers to Additional Activity
Algorithm to paint the room
1. Move furniture out of the room.
2. Cover the floor or carpet with newspapers or sheets.
3. Scrape paint from the walls.
4. Apply putty to cover cracks and holes in the walls.
5. Mix paint and oil.
6. Apply primer to the walls.
7. Apply the first coat.
8. Switch on the fan to dry the paint.
9. Apply second coat.
10. Apply varnish where needed after paint dries.
11. Paint the ceiling.
12. Paint the doors.
13. Clean the brushes and any paint spots.
14. Remove newspapers and sheets.
15. Move furniture back into room.
Additional Activity

Your room is being painted in your favourite colour! But the painters are quite disorganized. Help them paint your room in the best way by creating an algorithm and flow chart from the steps given below. Remember to number the steps in your algorithm.

Paint the ceiling. Move furniture out of the room. Mix paint and oil. Cover the floor or carpet with newspapers or sheets. Scrape paint from the walls. Apply varnish where needed after paint dries. Switch on the fan to dry the paint. Apply the first coat. Apply primer to the walls. Remove newspapers and sheets. Paint the doors. Move furniture back into room. Clean the brushes and any paint spots. Apply second coat. Apply putty to cover cracks and holes in the walls.
Teaching objectives

The objective of this chapter is to:
• introduce advanced features on the Insert and Design tabs

Learning outcomes

By the end of this chapter, the students should be able to:
• summarize different features of a multimedia presentation
• apply and use various PowerPoint commands.

Suggested number of periods: 2

Period 1

Sample lesson plan for a 40-minute period

This lesson should be conducted in the computer lab.

Starter activity (5 minutes)
Ask students if they remember how to make a presentation from last year. Ask them about the possible uses and applications of multimedia presentations. Expected responses: PowerPoint presentations are slides prepared on the computer using MS PowerPoint; they present information with brief text and audio/visual displays to a group of people; they are presentations in a dynamic slide show format, etc.

Templates (pages 63 and 64) (5 minutes)
Explain the concept of a presentation template in Microsoft PowerPoint. Help students access the different templates available in Microsoft PowerPoint and select one they like. Ask them to select an appropriate template for the topics given on page 64 of the textbook.

To help students write on the slide, ask them to follow the prompts ‘click to add title’ and ‘click to add subtitle’. If they want to change the slide layout, they should click on Design for a range of designs. All the designs will appear on the Ribbon and students can select a layout by clicking on it.

Alternatively, students can right-click the arrow below New Slide. A window pops out with several options. Students can click on a layout to apply it to their presentation. They can click on New Slide to add a slide to the presentation.

Features of the Insert tab (pages 65 to 66) (30 minutes)
Explain the function of the various features accessible from the Insert tab. Guide students as they learn the procedure for creating a photo album using the Photo Album feature. You could save some photographs of a school function or other school event on the computer and have students create a photo album using those.
Guide students through the process of inserting shapes and diagrams from the Shapes and SmartArt features on the Insert tab. Next, explain how a text box is inserted on a slide.

Explain the steps required to insert a video or audio clip to a particular slide on the presentation.

Ask students to answer the questions given on page 66 of the textbook.

Ask students to save their work for the next lesson.

**Period 2**

**Sample lesson plan for a 40-minute period**

This lesson should be conducted in the computer lab.

**Features of the Design, Transitions, and Animations tabs (page 67-68) (15 minutes)**

Ask students to open their presentations saved on the computer. Guide them to the Design tab and explain the function of the Slide Orientation feature. Next, explain the meaning of transition and help students edit the transition settings for their presentation. Finally, explain how animation effects can be inserted from the Animations tab.

Guide students to click on the Transitions tab for different transition effects. To hear sounds effects at transitions, they should left-click on Sound to open a drop-down menu where they can select from various audio options. Guide them as they set the transition timings.

**Word Whiz (page 68) (5 minutes)**

Ask students to attempt the Word Whiz activity given on page 68 of the textbook.

Assign the Explore with Whiz exercises on page 69 as homework.

**Whiz’s Quiz (page 70) (20 minutes)**

Help students explore and write down answers to the Whiz’s Quiz section in their notebooks. Encourage originality instead of copying text from the chapter.

**Answers**

Which of the following templates would you use to create a presentation? (page 64)

There is no right or wrong answer to any of these as it is a matter of preference. However students are likely to select template (c) for a presentation on plants, template (a) for a presentation on advantages of the Internet, and template (b) for photographs of a family vacation.

Which sound effects would you choose for a presentation on the following? Give reasons. (page 66)

A beach resort

Most students are likely to choose the breeze sound effect, but as long as they explain their reasons, any choice is acceptable.
An Independence Day celebration
Most students are likely to choose the drum roll sound effect, but as long as they explain their reasons, any choice is acceptable.

Define the following words with the help of a dictionary: (page 68)
orientation: the position or direction of something
transition: moving or changing from one state to another
animation: moving images created by a computer

Explore with Whiz (page 69)
Identify the words from the clues given below.
a pre-formatted layout: template
used to create a block diagram: SmartArt
one slide fading into the other: transition
the combination of various media: multimedia
portrait or landscape: orientation

Draw lines to join the commands to the icons that represent them.

choose a layout
make lists
add shapes
get a portrait orientation
change the theme colours
insert text
add sound effects
insert an image

Whiz’s Quiz
1. What is the main purpose of a multimedia program?
   The main purpose of a multimedia program is to use text, graphics, sound, animation, and video elements to convey a clear and memorable message to an audience.
2. **What is a template?**
   A template is a pre-formatted slide layout that helps us to make slides with the same design.

3. **What kind of graphics can we add through SmartArt?**
   We can add lists, process diagrams, block diagrams, pyramids, and cycles through SmartArt.

4. **Explain slide transition with the help of an example.**
   Slide transition is the movement from one slide to another in a presentation. We can choose from various slide transitions such as Fade, Push, Wipe, Split, etc.

**Answers to Additional Activity**
1b, 2a, 3a, 4b, 5a
Additional Activity

Choose the correct answer.

(1) Where can we select a template for our presentation?
   (a) Design group
   (b) Themes group

(2) Where can we select a slide layout?
   (a) New Slide
   (b) New Layout

(3) Which of these features is located on the Insert tab?
   (a) Photo Album
   (b) Shapes

(4) Which feature enables us to insert a chart on a slide?
   (a) Animations
   (b) SmartArt

(5) Where can we insert music on a slide?
   (a) Media group
   (b) Timing group
Teaching objectives
The objectives of this chapter are to:
• define a computer network
• discuss the different kinds of existing networks.

Learning outcomes
By the end of this chapter, the students should be able to:
• explain how computers are connected through different types of networks
• explain the role of the modem in networking
• summarize that sharing occurs because of the existence of networks.

Suggested number of periods: 3

Period 1
Sample lesson plan for a 40-minute period
This lesson should be conducted in the computer lab.

Starter activity (5 minutes)
Ask the students to answer the following questions before reading the chapter:
• What makes it possible for students working on computers in a computer lab to share information with one another (although they are seated at different computers)?
• Can we access the Internet from any computer? Why or why not?
• Have you heard the word ‘network’ before? What do you think it means?

Computer networks (page 72) (10 minutes)
Take students on a tour of the computer lab and indicate the cables linking the computers to one another. You might have to explain that some computers are connected to each other even though you cannot see cables connecting them. Explain the concept of a network as a group of computers connected through some wired or wireless means. Describe the function of the modem as a device to convert computer signals into a form that can carry along telephone lines.

Show how resources such as a printer and scanner can be accessed from all computers—a Print command from any computer in the lab will activate the printer. Next, show how a file/document from one computer can be accessed by a person sitting at another computer if the computers are connected by a LAN.

Types of networks (pages 73 and 74) (10 minutes)
Explain the different types of networks such as LANs and WANs. Explain that a LAN is restricted to an office or a building whereas a WAN is a larger network spread over a city or several cities. Samples of twisted-pair wiring, coaxial cable, and fibre-
optic cable can be shown, if available. This can lead the teachers to discussing WAN. The teachers can explain that LAN is used only if computers are in close proximity. However, if computers spread all over the world need to be connected, WAN is used.

Describe the different types of cables used to connect computers in a network. Explain that fibre-optic cables carry signals faster than any other type of cable. You may hint that wireless Internet technology has reduced the use of cables to some extent.

**Exercise (page 74) (5 minutes)**
Ask students to attempt the question given on page 74 of the textbook.

**The Internet (page 75) (15 minutes)**
Explain the concept of the Internet as a worldwide network of computers that enables people to connect with each other worldwide and share information. Describe the advantages of the Internet and the format of an IP address. You could open a web browser and show students how the Internet is accessed.

**Period 2**

**Sample lesson plan for a 40-minute period**

This lesson should be conducted in the computer lab.

**The World Wide Web (page 76) (10 minutes)**
Describe the World Wide Web and differentiate it from the global network (the Internet) which supports the sharing of information. Explain that the World Wide Web consists of a vast store of information in a variety of formats and media that can be accessed by any person with an Internet connection.

Ask students to attempt the question on page 76 of the textbook.

**Electronic mail (pages 77-79) (30 minutes)**
Explain the concept of electronic mail or email. It may not be appropriate to encourage students to create their own email accounts. So, you should open an account specifically for the lesson and demonstrate the process of composing and sending email. Explain all the steps shown on pages 78 and 79 of the textbook.

Have students take turns to sit at your computer and compose an email message from the email account you have created. Where sufficient time is not available, 2 to 3 students can be allowed to practise at a time.

Assign the Explore with Whiz exercises on pages 80 and 81 as homework.

**Period 3**

**Sample lesson plan for a 40-minute period**

**Whiz’s Quiz (page 82) (40 minutes)**
Help students explore and write down answers to the Whiz’s Quiz section in their notebooks. Encourage originality instead of copying text from the chapter.
Answers

Explain how Whiz can use a WAN to find a hotel in Dubai. (page 74)
Whiz can use a global WAN such as the Internet to find information about different hotels in Dubai. He can read their particular details and choose a hotel which matches his budget and tastes.

Which browser do you use to access the World Wide Web? List some of its features. (page 76)
The browser I use to access the World Wide Web is Microsoft Internet Explorer. Microsoft Internet Explorer lists the websites I visit most frequently and puts them in a visible place. The Notification Bar gives me information without getting in my way.

Explore with Whiz (pages 80 and 81)
Identify the features of the email window and write what each one is used for.
1. To: The email address of the receiver of the message is entered here.
2. Compose: Clicking this button enables us to compose a new email message.
3. Subject: The writer enters what the email is about in this space.
4. Attach: Clicking this button enables us to attach a file to the message.
5. Send: Clicking this button sends the email to the receiver.
6. Cc: Clicking on this button allows us to send an email to more than one person.

State whether the statements are true or false.
False.
True.
True.
True.
False.
False.

Whiz’s Quiz
1. What is a computer network?
   A computer network is a group of computers connected to each other. Computers on a network can access shared devices and information with one another.

2. State the difference between LAN and WAN.
   A LAN is a computer network spread over a small area that allows any device to interact with any other device on the same network. A WAN is a larger computer network which links computers over a wider area by modems, telephone wires, or satellites.

3. What is the function of a modem?
   A modem is a device which converts signals from the computer into a form that can be sent over telephone wires.

4. How do we send and receive messages through email?
   We send email messages by composing them in an email account and clicking on the Send button. The message is delivered electronically to the receiver’s email account. Similarly, email messages from others arrive in our email account. We can read them by clicking on them in the Inbox.
Additional Activity

Connect the computers by drawing lines so that each computer is connected to every other computer and to the server by a minimum length of lines. Using a ruler, measure the total length of the lines drawn. Compare it with the length of those drawn by your classmates. The shorter the total length, the more efficient your network is.